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GEOTERRAIN (MICROSTATION)

A szoftver fobb ismérvei

A MicroStation felépitése

A MicroStation alapvetden egy CAD szoftver, melyet a mérnoki feladatokon tal sza-
mos, egyéb célra haszndlnak szerte a vilagon, pl. térinformatikai feladatok megoldéaséara
is. Az évek sordn szamos ilyen irdnyu kiegészitd szoftvert fejlesztettek a MicroStation
ala.

A program allomanyforméatuma a design f4jl (DGN), mely kizardlag vektoros rajzi
elemeket tartalmazhat, és lehet két- vagy haromdimenzios. Az dllomany rétegstrukturalt,
a program egy fajlon beliil 6sszesen 63 level-t képes kezelni. A 3D-s DGN-ben négy nézet
talalhato: feliil-, el6l-, oldal- és egy tetszOleges madartavlati nézet.

Mivel a MicroStation a raszteres fajlokat csak elemi szinten kezeli, ezért a munka
soran —a LANDSAT kép kapcsédn — hasznalnom kellett még a Descartes nevil szoftvert,
melyet a Bentley kifejezetten képfeldolgozasra készitett.

Fontos megemliteni a referencia fajl opcidt, mely lehetévé teszi, hogy egy DGN
allomény ,,hatterébe”, tetszéleges szdmu raszteres képet és design f3jlt illessziink. Erre
tobbek kozt azért lehet sziikségiink, mivel a design fajlok mérete nem haladhatja meg a
32 megabyte-ot.

A GeoTerrain

Ez a MicroStationnel egyiitt automatikusan indulo, kiegészit6 alkalmazas lehetévé
teszi, hogy feliiletmodellekkel dolgozzunk MicroStation alatt. A szoftverrel haromszog-
¢s négyzetracsmodelleket készithetiink, és rajtuk kiilonboz6é miiveleteket hajthatunk
végre. A modellek és egyéb produktumok végiil az éppen megnyitott DGN allomény
részévé valnak, melyet célszerli 3D-s tipusunak bedllitani. Miel6tt egy miivelet ered-
ménye grafikus elemként megjelenne a design fajlban, lehetdség van az elemek grafikai
tulajdonsagainak beallitdsara (célréteg, szin, vonaltipus, vonalvastagsag).

A fentiekbdl az is kovetkezik, hogy eltéréen a masik két szoftvertdl, itt a
négyzetracsmodell is vektoros allomanyként jelenik meg, ami jelentdsen noveli a prog-
ram erdforrasigényét.

A GeoTerraint az Applications meniipont alatt talaljuk. A programhoz 6nall6 tool-
bar és meniisor tartozik, ezeket kiilon kell elinditani.
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A szoftver funkcioi

Feliiletmodellek készitése

A kiilonbozo feliiletmodellek készitése harom 1épcsdben torténik. E16szor a forras-
allomanybol 1étrejon egy DAT fajl (szoveges vagy binaris). Ebbdl az allomanybdl késziil
el a TIN, majd ez utdbbibdol a lattice (négyzetracs) modell. A feliiletmodell
paraméterezésére elsOsorban a DAT fajl elkészitésekor van lehetdség. A TIN ¢€s lattice
modellek elkészitése tobbé-kevésbé egyszerli adatkonverzio. Itt jegyzem meg, hogy a
GeoTerrain képes rogton terepmodellt késziteni, vagyis a 1étrejovo DAT allomanyban az
egyes pontok nemcsak magassagi adatokat reprezentalnak, hanem egy¢éb informéciok is
kotddhetnek hozza.

Adatnyerés 3D-s design fajlbol Az adatnyerés az éppen megnyitott DGN allomanybol
torténik. Meg kell adnunk, hogy a fajl mely elemeibdl szeretnénk kinyerni a
koordinatakat: a réteg, stilus, vonalvastagsag, tipus és szin akarmelyikének — vagy mind-
egyiknek — a megadasaval. A felkinalt lehetdségek koziil ki kell valasztani az elemekhez
tartozo tulajdonsagokat (pl. pontok, torésvonalak, hatarvonalak stb.). A Mode-dal beal-
lithatjuk, hogy a feliiletmodellhez az adatokat valtozatlan forméba vigyiik-e be, vagy
interpolalassal 0j adatokat hozzunk létre. Ily mdédon készithetiimk domborzatmodellt,
mar meglévd szintvonalrajzbol.

# GEDPAK - Extract Graphics

File Marme |c \copyhokhoopyh 5. dat Files I
Filz type _Binary h
File open  Create

=
Feature _Spots 7
Mode _Estraction i

Select Criteria

W ilevelss  Select [T Stles  Select |
™ Weights  Select [T Types  Select I
" Colors |

Match | Display | Reset |
Extract
e~ ooy |

DAT fajl készitése szoveges allomanybol » Ezzel a modszerrel X, Y és z koordinata
oszlopokat tartalmazé szovegtijlokat olvashatunk be. Meg kell adni az egyes oszlopok
tipusat, mely az Xyz koordinata értékeken tul lehet még tobbféle tematikus kod is, ami a
pontok valamilyen tulajdonsagat adja meg, vagy bizonyos pontok kozti kapcsolatra utal.

Input File | o hoopyhokhustationhalaphddmb0. syz ﬂl
Output File | o hoopyhokhoopysS0.dat ﬂl Create ¥
Conterts of File miter _ Space vI Comment Defimiter _Mone ¥
3 4331150.00 530245000 249 E
4 4331200.00 5302450.00 254
1 4331060.00 H302450.00 245 ﬂl

None | % x| v | z ¥| None -| Next>>|

F__E__al_f‘__'?‘c"ds Feature Setting
EIEES
Output File Format : - Binary vI

Process

Extract >
Extract
Graphics

Extract >

Extract xvz
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Adatnyerés DEM fajl atalakitasaval ¢ A DEM (DIGITAL ELEVATION MODEL) az USA szab-
vany digitalis domborzatmodell formatuma. Meg kell adni a forras allomany vetiileti
rendszerét és kezdd meridianjat és hogy kivanjuk-e az atalakitds soran csokkenteni a
pontok szamat.

Egyéb szoveges formatumok atalakitasa » Lehetoség van mas, hasonlo szoftverek altal
készitett szoveges allomanyok feldolgozéasara is. A tdmogatott fajlformatumok: TEX,
THD, RT 40, CAICE.

TIN eléallitasa « A DAT fajlbol elsé 1épésben haromszogmodellt készithetiink. Az
egyetlen paraméterezési lehetdség: a modell peremén 1év6é haromszogek kiszamitasanak
modjai.

DataFile : [ c\copyhokhustationhalaphei.c. M

TIM File : | c:copysok'copyhS0.tin iFiies

Dizzolve Option:  Mone |

Frocess |

Lattice eldallitasa » Csak a TIN modellbdl készithetjiik el a négyzetracsmodellt. Az
interpolalasi modszer megadasan tul, a cellak és a racs méreteit szabalyozhatjuk. A fel-
bontast megadhatjuk az egyes cellak méretével és az 0sszes cellak szamaval is. A racs-
halé méretét a hatarold vonal X és Y koordinatdinak megadasaval szabalyozhatjuk.

£ GEOPAK - Build Lattice

TIM File : Ic:\copy\ok\ustalion\alap Files

LAT File : |[ c:\copyhok \copyh5il.lat Files
Interpolation : Planar I

Lattice Option: ~ Set

Lattice Intervals
# Interval : | 50000000 *f Interval : | 50000000

# Register : | 0.000000 " Regizter : |D.DDUUDD

Process |

Miiveletek a haromszogmodelleken

A GeoTerrain segitségével szamos elemzést készithetiink. Ezeket kizardlag TIN
modelleken lehet végrehajtani. Minden eredmény az €ppen nyitott DGN allomanyban

jelenik meg. A miveletek végrehajtasa elott donthetlink arrdl, hogy a késziild abra csak
megjelenjen-e a kivant ablakban, vagy pedig a design fajl részévé valjon.

Tematikak szinfokozatos abrazolasa ¢ Harom kiilonb6z0 téma szinfokozatos abra-
zolasara van lehetdség: magassag (hipszometria, Elevation), meredekség (lehet szaza-
1€kos vagy fok alapu, Slope) és a kitettség (Aspect). Eltéréen a masik két szoftvertol, itt

Extract >
Extract DEM

Extract >
Extract Set
Format

Build >
Triangles

Build > Lattice

Analysis >
Themes
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nem keletkezik 0j feliiletmodell, hanem egyszerlien a meglévé magassagi modell tema-
tikus kiszinezésérdl van szo.

EX A
TIN File | C:hcopyhaokustation'alaphS Files I

I Humber of £rd Ports: [0
- Display
¥ Display Orly Level EI
[ Load Within Fence |

[~ Set Graphic Group hd
I Fill

~ Options
™ Planarize at Elzvation |U.UUU

™ Polygonize Results

Set Range I Process I

Az allitasi lehetoségek az Gsszes esetben azonosak. Az eredmény maradhat TIN
alapti, de megjelenhet gridként is, ha megadjuk a leendd grid pontjainak szamat. A
hatarértékek és a hozzajuk tartozd szinek megadésan tul beallithatjuk a vonaltipust és
vastagsagot valamint, hogy az abra melyik rétegre keriiljon. A hatarértékekre vonatkozo
beallitasokat elmenthetjiik. Lehetdség van ra, hogy az azonos — magassagi, meredekségi
stb. — tartomanyokba esd haromszogeket, vagy négyszdgeket dsszefliggd poligonokka
alakitsuk. Ezzel jelentésen csOkkenthetjlik a keletkezd allomany méretét. Az abrat akar
kétdimenzidssa alakitva is megjelenithetjiik.

Magassagkiilonbség szamitas * A funkcid egy TIN magassagat vizsgalja egy masik TIN-
hez, vagy egy adott magassaghoz tartozé sikhoz képest. A viszony lehet metszd6, egymas
felett levd, vagy megegyezd. Az eredmények megjelenhetnek:
- Pontracsként, az eltéréseket egy eldre beallitott stirliségli ponthaldzat pontjaiban
vizsgalva. A pontokat tetszéleges szimbolumokkal helyettesithetjiik.
Lattice modell forméjaban, a feliilet egészére vizsgalhatjuk az eltérést, a racshalo
teriiletei a viszonyoknak megfeleld szintiek.
Izovonalak formajaban, melyek az azonos eltérésii pontokat kotik Gssze, a
viszonynak megfelelen szinezve.
Mindharom elemzési mddszer esetén eldonthetjiik, hogy mely viszonyok jelen-
jenek meg eredményként. Itt is lehetéség van az eredmény kétdimenziossa vald
alakitdsara.

Metszetkészités » Metszetet készithetiink egy mar meglévd vonalas elem, vagy egy fris-
siben kijeldlt vonal mentén. A beallitdsokat egy harom részbdl allo parbeszédablakban
tehetjliik meg. Az elsében ki kell vélasztani az elmetszendd TIN-eket, megadva az adott
TIN-hez tartoz6 metszet grafikai tulajdonsagait (szin, vonal tipus stb.). A masodik ablak-
ban nézhetjiilk meg a metszetet. Itt valaszthatjuk ki a metsz6 vonalat, vagy rajzolhatunk
Ujat. A harmadik ablak a metszetet tartalmazo koordinatarendszer tulajdonsagainak beal-
litdsara szolgal: horizontalis és vertikalis torzitds mértéke, tengelyek minimalis és maxi-

Analysis >
Elevation
Differences

Analysis >
Profile
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malis értékei, tengelyek osztas stiriisége és ezek feliratozasa stb. Végiil visszatérve a
masodik ablakba — amennyiben elégedettek vagyunk az eredménnyel — a Place Profile
gomb lenyomasaval beilleszthetjiik a grafikont a design fajlba.

& GEDPAK Site Profile x # GEDPAK Site x|

Selecliunl Prrofile I Preferences ] Selection ] meile] Preferences ]

Level Color ‘Weight Style Estract

Select Element I Place Element | Place Prafile Curve Stroking IU [iil])

|- Extracted Profile View

TIM File C:hcopyhok ustation’alap Files | Lv4 _ I~

Lefolyasvizsgalat « Szamos lehetdség van a terep vizfolyassal kapcsolatos vizsgélatara.
Az eredmények tobbsége grafikus elemként beépiilhet a DGN dllomanyba. Els6 1épésben
egy Uj TIN fajlt készithetlink, a kivalasztott alapjan, melyben a haromszogek
kialakitasakor a program figyelembe veszi a terep fontos pontjait és idomvonalait. A
késébbi vizzel kapcsolatos szamitasokat nagyban meggyorsitja az igy modositott TIN
hasznalata.A kovetkez6 vizsgalatokra van lehetdség:

Vizvalasztok megrajzolasa

Vizvalasztok megrajzolasa egy sziikebb teriileten

Lefolyéasi nyilak megrajzolasa

Adott pontbdl kiinduld legnagyobb lejtésli vagy legnagyobb meredekségii vonal

megrajzolasa

A feliiletmodell lokalis minimum vagy maximum pontjainak megjelolése

TIN File: || (=l Bl | Files

Options ——————

h] 27

[~ Use Boundary Luw1 =

Selection Criteria

DF

Pour Paint

DP
Create Shape

Pick Boundary
Elements

Meérések a haromszogmodellen

Magassagszamitas « A TIN modell teriiletére kattintva megkapjuk az adott pont X, Y és
z koordinatait, valamint a ponthoz tarozé hdromszog meredekségét. A képernydre kiraj-
zoltathatjuk a ponthoz tartoz6 szintvonalat, haromszoget és lejtésiranyt. Megtehet;iik,
hogy a pont magassaga az éppen aktualis rétegen szoveges elemként rogziil.

Analysis >
Drainage Tools

Analysis >
Height
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Feliiletszamitas » A funkcié megadja a kivalasztott TIN egészének vagy csak egy
részének, a tényleges és a sikra vetitett terliletét négyzetméterben vagy négyzetyardban.
Az eredményt kiirja a képernydre, elmentésére nincs mod.

Térfogatszamitas » Térfogatot szdmolhatunk két TIN, vagy egy TIN és egy adott magas-
sdgu vizszintes sik kozott. A szamitds vonatkozhat a TIN-(ek) egy kisebb részére is. A
mérést végezhetjiik haromszogmodell alapon, ilyenkor a mérendd teret haromszog alapu
guldkra bontja. A masik modszerrel eldszor kiszamolja feliilet(ek)re vonatkozo
négyzetracsmodellt, majd a keletkez6 hasdbok térfogatidt szdmolja ki. Ez utdbbi a
gyorsabb, és pontatlanabb.

Eredményként megkapjuk a feliiletek kozti térfogatot, a metszd részek kozti tér-
fogatot, a kettd kozti kiilonbséget, valamint a mérési teriilet nagysagat. Megadhatunk
magassagi tartomanyokat is, ekkor az eredményeket a beallitott sdvok szerint lebontva
kapjuk és szoveges formatumban elmenthet;jiik.

# GEDPAK. Load DTH Features
File

Load File _TIN 'I o hdokumentumok \gergotdiplome FiIesI Load |

- Display Pref
Load _Extent vI ™ Display Only ™ Gray

Feature Level Color  “weight Style Display

Triangles 1 0 0 i OFF |~ %1
Tin Hull

1 0 1] Juy] ™

2
Maior Lines 1 3 0 0 OFF v
Major Lahel 3 3 1] [i] OFF ]
Minor Lines 2 E o 1} OFF

Minar Interval | 10,000 Major [nterval |50.UDU

¥ Smaoth Cantours Registration | 0.000 Mirimum Area |U.UUU

Range ¥ Minimum Z |B?.UDU M asimurn £ | 755.000 Read I

A feliiletmodellek megjelenitése

Mivel 3D-s design fajllal dolgozunk, igy a fjlon beliil minden nézet haromdimen-
7i0s, csak a nézOpontok térnek el egymastdl (feliilnézet, oldalnézet stb.).

A modellek droétvazas és szintvonalas megjelenitése « Mindharom feliiletmodell tipust
(DAT, TIN, lattice) megjelenithetjiik, vagy a DGN f4jl részévé tehetjiik. A DAT f4jlt pontok
formdjaban, a TIN-t haromszdgekkel, a lattice-t négyszogekkel jelenithetjiik meg.

TIN és lattice modellek esetén lehetdség van a feliilet szintvonalas megjelenitésére.
Megadhatjuk a {6- és alapszintkozt, a kezdd szintvonal értékét, és az egy szintvonal altal
hatérolt minimalis teriilet nagysagat. A harom szoftver koziil egyediil itt van lehetdség a
szintvonalak automatikus megirasara.

A fentieken kiviil szdmos egyéb tulajdonsagat lehet megjeleniteni a feliiletmodel-
leknek (pl. torésvonalak), de ezekre nem térek ki részletesen.

Summer készitése » A feliiletek arnyékolt megjelenitését a MicroStation teszi lehetdveé
a renderelési funkciok segitségével. A szinte megszamlalhatatlanul sok allitasi lehetdség
koziil csak a legfontosabbakat emelem ki.

Haromféle megvilagitas koziil valaszthatunk, melyek mindegyikénél allithatjuk a
fény szinét €s erdsségeét. A szort fény (Ambient) a feliiletrdl visszaver6do fényt jelenti,
hatdsa fiigg a feliilet anyagatol (1asd késobb), arnyékot nem vet. A nézOpont iranyabol

Analysis >
Slope Area

Analysis >
Volumes

Load >
DTM Feature

Settings >
Rendering
Utilities >

Render
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vilagité pontszerli fényforras (Flashbulb) sem vet arnyékot. Végiil lehetdség van a
valédi napfény szimulalasara is. A Nap poziciojat megadhatjuk polaris és sik
koordinatakkal, de megadhatjuk a célteriilet foldrajzi koordinatait, hozza a datumot és
idépontot. Ezeken kiviil lehet6éség van 0jabb fényforrasok definidlasara, ezek lehetnek:
tavoli-, pontszeri-, spot- €s feliiletszert fényforrasok.

& Global Lighting x| Laocation By Map []
I Ambient Inkenzity: |D.30 Nomem Full Colar...

I™ Flashbulb  [rrensiy |1.UD Nomem Full Colar...
I Solar Intensity: |1.UD Nomem Full Color...

* ™ Solar Shadows

Salar Shadow Resalitior: [512 1) x| e s [

Solar Direction Yector # [-0500 | ¥ [0.4330 0 2 [0.7070 | W Lock

Azimuth Angle: | 315.00 Alitude Angle: | 45.000

Location Time
Longitude: |-?5 o Tirne: |1[I |EI[I AM ¥
Latitude: |39 o Daylight
GMT Offset |-ED Date: _July |1
ear [155 | Latituge: [47 | * [30 Longinde: [13 | * [5 GMT Offset: [1.0 |
Citiez... | Map... | Zones... |
\ Cancel |

. ™ Add Sky Light to all Solar and Distant Lights Caolar. Latitude Langitude Offset
e 432N 7415w E=

Eombay 18:0M T2:48E 55

Bordeaus 44504 037w 1

EBrussels 50:52M 4.22E 1

N 1
Eucnis Aires 34:205 B30 3
Cairo 30:00M 3117E 2 J

Calcutta 22324 83228 ES

Cape Town 33568 18:22E 2

Caracas 10:28M E7: 2w 4

Coperhagen B5:40M 12:34E 1
Delhi 28:30M TE:50E 5.5 =1

oK I Cancel |

Lehetdség van a feliiletet kiilonféle tulajdonsagi anyagokkal (Materials) vald
boritasara. igy szimulalni lehet — mivel elsésorban mérndki programrél van sz6 — pl. egy
tervezett faépiilet megjelenését valdos megvilagitasban. Egy specidlis burkoléanyag, a
dcdrape lehetové teszi a feliiletek raszteres képekkel (pl. tirfotd) vald burkolasat.

A feliiletre érkezo fény hatdsanak szamitasara is tobb lehetdséget kinal a program.
A Constant és Smooth mddszerekkel a feliilet szinezését, a modellt alkot6 poligononként
végzi el, bar az utébbi egyenletesebb képet ad. A Phong modszer esetén nem torddik a
poligonokkal, hanem pixelenként szamitja ki a beesé fény hatasat. Ez adja a legszebb
képet. A Phong eljarassal készithetiink 3D-s, anaglif képet is.

Egyéb funkciok

Animaciok (repiilés- és napmozgas szimulicio) « Hasonldan a summer készitéshez
ezeket a feladatokat is a renderelésen beliil lehet megoldani, hasonlé szdmu allitasi
lehetdségen keresztiil. A képek és filmek rogzitéséhez szamos kamera és lencsetipus
koziil valaszthatunk. A felvétel soran mozoghatnak a kamerék, a fények és a modell is.
Lehetdség van tobbek kozott erdok szimulalasara is.

Repiilésszimuléciot legegyszeriibben ennek a funkcionak az alkalmazasaval készit-
hetiink. A kamera beallitdsakor meg kell adni a latoszoget, a fokusztavolsagot, a lencse

Utilities >
Render >
Fly Through

Utilities >
Render >
Solar Study
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tipusat és a latotavolsagot. Valasztani kell, hogy a kamera — fliggetleniil a mozgéstol —
mindig csak ugyanazt a pontot nézze-e, vagy pedig a kamera fix beallitdsokkal mozog
¢s mindig azt rogziti ami elékeriil. A terep kapcsan meg kell adni a feliiletet tartalmazo
View-t, az arnyékolas fajtajat, a képek rogzitési sebességét, a felbontas nagysagat, és a
gamma korrekciot. Ezek utan mar csak a rogzitendé képkockak szamat kell megadni
valamint a repiilési utvonalat kell megjeldlni.

A napmozgas szimulacional a tereppel kapcsolatban ugyanazokat kell rogziteni,
mint a repiilésnél. Ezenttl csak a szimulacié kezdetét jelentd datumot és idopontot kell
megadni, valamint a szimulaci6 idobeli hosszat. A szimuldcié megkezdése elétt meg kell
hatarozni a terep foldrajzi helyzetét (lasd Summer készitése).

Grafikai elemeknek a modellre illesztése * A funkci6 segitségével az eddig egy sikban
elhelyezkedd pontokat, vonalakat és feliileteket valodi haromdimenzios elemekké kon-
vertalja ugy, hogy pontosan illeszkedjenek az alattuk levé TIN modellhez. Nincs mas dol-
gunk, mint kijeldlni a transzformaland6 elemtipusokat és, hogy melyik rétegen
helyezkednek el.

DAT fajlokkal kapcsolatos miiveletek ¢ Lehetéség van a DAT fajlok utdlagos
szerkesztésére, modositasara. Szerkeszthetjiik a szamitasok soran megduplazddott pon-
tokat €s az egymast keresztezd torésvonalakat. Csokkenthetjiik a pontok szamat,
Osszekothetjiik a kiilonb6z6 vonalas elemeket, €s kivaghatunk egy elkeritett darabot.
Végiil oda-vissza atalakithatunk a binaris és szoveges formatum kozott.

TIN fajlokkal kapcsolatos miiveletek * Az elsé metodus az elkésziilt TIN ellendrzésére
szolgal. A masik segitségével pedig mas néven is elmenthetiink egy TIN-t.

Lehetdség van két, mar meglévd TIN ,,0sszeboronalasara”, ha azok legalabb egy
pontban fedik egymast. A kozos teriileteken a masodiknak megadott TIN értékei fognak
szerepelni.

A kovetkez6 funkcidval pedig egy darabot vaghatunk ki egy TIN-b6l. Eldonthet;jiik,
hogy a kivagott darabot mentjiik-e el egy 0j alloményba, vagy a ,lyukas” TIN-t
szeretnénk megtartani.

A TIN Edit funkcidval lehetdség van egy TIN barmely elemének tetszdleges
megvaltoztatasara.

Jelentések készitése « Ennek a meniinek a kiilonb6z6 opcioi lehetdséget adnak ré, hogy
a DAT, TIN ¢és lattice modellek allapotat leird szoveges allomanyokat készitsiink.

Exportalas « A ,nyers” TIN vagy lattice allomanyok exportalasara nincsen lehetdség.
Csak ha mar beolvastuk 6ket egy design fajlba, akkor lehet exportalni a MicroStation6én
keresztiil. A tdmogatott formatumok: DWG, DXF, IGES, CGM, GRD, Qick Vision, VRML
World.

Drape >
Vertices

Edit

Utilities >
ASCIl to Binary,
Binary to Asci

Utilities >
Check
Triangulation,
Convert TIN

Build >
Merge TINs,
Clip 1IN

Edit > Triangles

Reports
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A program hasznalata

Els6 1épéskeént egy 1) 3D-s DGN allomanyt hoztam Iétre. Majd fomértékegységnek
a métert allitottam be gy, hogy a koordinatakat centiméter pontossaggal adja meg. Ezzel
megfeleld nagysdgira noveltem a munkateriilet méretét.

Feliiletmodellek készitése

Két modszerrel is elkészitettem a DAT fajlt.

Eldszor az Extract xyz metddust probaltam ki. A szdmitasok kdzben — maig nem
tudom miért — a program tObbszor lefagyott, és csak hosszas probalkozasok utan
készitette el a DAT fajlt.

A Masodik modszernél a ddm50.xyz allomanyt importaltam a koordinatapontokat
a design f3jlba, ahol egy 6sszefliggd vonalas elemként jelentek meg. Ezutan az Extract >
Graphics opcidval — megadva a forrasgarfika adatait €s a tulajdonsagat Spots-ra allitva
— elkészitettem az 50.dat allomanyt.

A Build 1iN-t hasznalva létrehoztam a haromszogmodellt. A lattice elkészitésekor
(Build Lattice) a Set metodust hasznéaltam, 50-50 méterre allitva az Xy intervallumot.

A tematikak elkeészitese

A kiilonbozd tematikdk eredményeit mindegyik szoftver esetén, altalaban valami-
lyen raszteres formaban mentettem el. A legszebb képet a Utilities > Image > Save
funkcid készitette. Ennek a megoldasnak az volt a hatranya, hogy — nem tudni — miért,
csak a tematikdkkal kapcsolatos elemeket rogzitette a képen, a tobbit (pl. vizrajz,
szelvénykeret stb.) nem.

A kiilonbozd Osszelatasi és belathatosagi vizsgélatokkal kapcsolatos tematikdk
elkészitésére nem volt lehetdség, mivel a szoftvernek ilyen irdanyt funkcidi nincsenek.

[Zvimion 2

nnnnn

0000 Maorneval [50000_
e A [000  Meinun vea [050
imunZ [E7000— Masirun2 [755000 | _Read

LT TR "l 2| 6+ =D oo e Gl >
DTHTOOLS ANALYSIS THEWES 2 Update View = [[= 8 JLevei=1 [IC]
ShSton| (5] Exlong - Gergo [F2i50szint don (3D) - Mi... FZiMitcStaion Ted Window 121

Tools >
Annotation >
Xxvz Text >
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Szintvonalrajz ¢ Ez a szoftver kinalja a legtobb paraméterezési lehetoséget a szintvo-
nalszerkesztés kapcsan. Egyediil itt van lehetdség a szintvonalak megirasara, sét a
megirdsok méretét és surliségét is lehet szabalyozni. A szintvonalakat mindkét modell
alapjan elkészitettem. Kihaszndlva a program masik hasznos funkcidjat, az egy
szintvonal altal lefedhetd minimalis teriiletet 10 m*-re allitottam. Ezzel tobbé-kevésbé
kikiiszoboltem az interpolalasbdl szarmazd, a valosdgban nem létezd gdodroket és
halmokat.

Hipszometria, meredekség, kitettség o Mivel ezt a harom tematikit ugyanazzal a
funkcidval és azonos paraméterezési lehetdségekkel lehetett elkésziteni, ezért egyiitt tar-
gyalom &ket. Alapbeallitasként, a TIN modellt szerkeszti meg a program, a harom-
szogeket az adott tematikanak megfelelden kiszinezve. Ekkora forrasallomany (TIN)
esetén sajnos, a miivelet teljes végrehajtasahoz nem elég a 32 megabyte. A megoldast az
azonos kategoridba esd haromszogek poligonokka torténd egyesitése jelentette. Ennek a
funkcidnak a hasznalataval a fajlok mérete kb. 1%-a lett a kordbbiaknak.

A program a feliileteket rajzi elemenként arnyékolja. A feliiletek ebben az esetben
néhany nagyobb poligonbdl alltak Ossze, ezért arnyékolasi célokra alkalmatlanok
voltak.Ez nagyban csokkentette a térhatas érzetét.

Summer ¢ Az arnyékolassal kapcsolatos minden funkci6 a MicroStationben talalhat6.
Az éllithaté paraméterek szama olyan nagy, hogy ,,igazan mindségi” eredmény pro-
dukaldsahoz itt is hosszabb tapasztalatszerzésre lett volna sziikség. Az elobb azért
hasznaltam i1dézdjelet, mert véleményem szerint, még igy is ezzel a szoftverrel késziilt a
legszebb summer.

A lattice modellt a Finnish-White anyaggal boritottam, mivel ez vilagos és a tobbi-
hez képest j6 a fényvisszaverd képessége. A feliiletet egyediil fehérszinii, szoléris
fénnyel vildgitottam meg, maximalis erével, vetett arnyékok nélkiil. Arnyékolasi meto-
dusnak a phong modszert valasztottam, mivel ez pixelenként szamitja ki a beesé fény
hatasat a feliiletre és igy a legszebb képet adja.

Metszet » A TIN DK-ENy-i iranyi metszetének elkészitése semmi nehézségbe nem
itkozott. Ennél a funkciondl is részletekbemenden lehetett szabalyozni a
koordinatarendszer kiilalakjat és megirasait. Egyetlen problémat tapasztaltam csak: a
program nem engedte meg, hogy a fliggdleges tengely szdmozasa nullatdl kezdddjon,
annak ellenére, hogy ilyen allitasi lehetdség 1étezik.

Urfoto » A légi- vagy firfotonak a dombormodellre valé illesztéséhez sziikség volt a
Bentley egy masik bedgyazott szoftverére, a Descartes-ra, ami a képfeledolgozast és a
képmanipulalast teszi lehetdvé MicroStation alatt. Els6 1épésben a feliiletet egy specialis
anyaggal, a Dcdrape-pel kell boritani. Ez a matéria a Descartes-hoz tartozik és ez teszi
lehetdvé, hogy a korabban megnyitott és helyére igazitott képet a feliiletre illessziik. Itt
is csak szolaris megvilagitast alkalmaztam, megadva a szelvény kozéppontjanak fold-
rajzi koordinatait, valamint a felvétel késziiltének idépontjat. A napfény irdnydnak ilyen
moddon valdé megadésaval egyediil ennél a szoftvernél talalkoztam.
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Térkép és fototérkép A DTA-50 szelvény elemeinek hdromdimenzdssa valo alakitasa
csak részben sikeriilt. A probléma a Drape > Vertices funkciéval volt. A program, az ata-
lakitas folyaman egy végtelen ciklusba keriilt, Ujra meg Gjra atalakitva ugyanazokat az
elemeket. A ciklust CTRL+C-vel megszakitva a transzformalasra kijelolt elemek részben
illeszkedtek a feliiletre, részben nem. Ezért nem tudtam a teljes térképet haromdimen-
zi6ssa alakitani.

Repiilés » A repiilési szimulacio kb. 2000 méter magasan torténik egy, a szelvény
teriilete feletti semmihez sem kapcsolodo, kanyargds vonalat kdvetve. A szimulaciot
kiilonb6zd lencsebeallitasokkal is megcsindltam. Az eredményt Avi forméatumban
mentettem el.

Napmozgas-szimulacio ¢ Az arnyékok valtozasat két feliileten is modelleztem: a
LANDSAT képet tartalmazo modellen a kép késziilésének napjan (1990. julius 23.), és
egy egyszerli summeres feliileten 2000. janius 21-én. Mindkét idopontban napkeltétol
napnyugtaig. Az eredményt itt is AVI formatumban rogzitettem.

Egyéb funkciok vizsgalata

Vizzel kapcsolatos vizsgalatok * Végigprobaltam az §sszes Drainage lehetdséget, a tel-
jes TIN modellre. Az aramlasi nyilak megszerkesztését leszamitva (a fajlméret megha-
ladta a 32 MB-ot), a program az 0sszes elemzést sikeresen végrehajtotta.

Magassagkiilonbség kiszamitiasa ¢ Kiprobaltam még két haromszogmodellnek az
egymashoz viszonyitott relativ magassagkiilonbségének abrazolasat is. A DDM-10
alapjan készitett DDM-50-b6l és DDM-200-bol késziilt TIN-eket hasonlitottam dssze.

Sztereo kép ¢ A kiilonbozd arnyékolasi metddusok kozt szerepel a Phong Stereo is,
mellyel olyan térhatasu képet készithetiink, amit kék-vords szemiiveggel lehet vizsgalni.
A summerkészitésnél hasznalt beallitasokat alkalmaztam ennél az opcional.

Nyomtatas * A MicroStationbdl valé nyomtatas elég nehézkes. A program csak a
képerny6n lathato teriiletet képes kinyomtatni, az aktualis vagy annal kisebb méret-
ardnyban. Igy csak akkor sikeriilhet 1:50 000-es méretaranyu térképkivagatot Ad-es
méretben kinyomtatni, ha sikeriil a képernyOn is pont ebben a méretaranyban megje-
leniteni a térképet. Ezért inkabb a méretarannyal nem torédve nyomtattam ki egy kisebb
részletet a szelvénybdl.

Exportalas A TIN és lattice modelleket tartalmaz6 design fajlokat DXF és VRML World
formatumba exportaltam.

Tapasztalatok Osszefoglalasa

A MicroStation elsérban egy professzionalis mérnoki szoftver, ahol a pontossag és
a rajzi elemeken végezhetd bonyolult geometriai miiveleteken van a hangsuly. Ekkora
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terliletnek, ilyen felbontasban val6 igényes haromdimenzios és tematikus megjelenitése
tobb esetben meghaladta a szoftver képességeit.

A GeoTerrainben — 0sszehasonlitva a masik két feliiletmodellezé szoftverrel —
sokkal tobb és pontosabb matematikai elemzésre van lehetdség a feliiletekkel kapcsolat-
ban. A program fejlesztdi inkabb a szamitasok és eredmények megbizhatdsagara €s nagy
pontossagara helyezték a hangstlyt, mintsem a megjelenités mindségére.

Ezaldl egyediili kivétel a MicroStation renderelési funkcidja, melynek allitasi
lehetdségei messze meghaladjak a masik két szoftver ilyeniranyu képességeit.



